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» This step-by-step tutorial demonstrates how to implement the fatigue

check according F.E.M. 1.001 and Eurocode 3 in SDC Verifier.
» FEM 1.001 Fatigue and Eurocode 3 detailed review;
» Implementation in SDC Verifier;
» Weld Finder Tool overview;
» Fatigue tables and plots;

» Report preparation and results.
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Fatigue F.E.M. 1.001

Allowable Stress Design method [permissible stress)
oy N/mm2
2t Iot =240
The following formulae give for all values of k the permissible stresses for fatigue |
- 7,
7 e . Y // /
- for tension : o=5.04/(3-2.x) (1) 200
/ 7 4
- for compression : 0e=2.04/(1-%) 2 ////ﬁ/ /
ow is given in table above % " -~ s 4
"o ' =z A A
b) p—_— :',' % — 1 /
- for tension 6t=0o/[1-k.(1-00/0+)] (3) w— L] - 100
K2
- for compression c.=12.0 (4) ” /// -
_.,---"’/ 50
K‘ e
where oo = tensile stress for k = 0 is given by the formula (1) that is :
oo = 1,66 . ow 0 K
10 08 06 04 02 o0 02 04 06 08 10
o+ = tensile stress for k = + 1 that is the ultimate strength or divided by the coefficient of safety Ratio between the extreme stresses
43 on =0,75. or Figure A.3.6.1. - (A 52; tension; group E6)

o is limited in every case to 0,75 . or .

By way of illustration, fig. A.3.6.1. shows curves giving the permissible stress as a function of
the ratio x for the following cases :
- steel A52 ;
- predominant tensile stress ;
- group E6 ;
- construction cases Wy, W4, W> for unwelded components and cases of construction for
joints Ko to K.

The permissible stresses have been limited to 240 N/mm?, i.e. to the permissible stress adopted
for checking for ultimate strength.
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Fatigue in SDC Verifier

[¥" Add Custom Check - O x
Kappa Factor
Options
Kx = Oxmin / Ox max 1D |2 | Title |Fatig|.|e Check | Calculate Results
Ky = Oy min l Oy max Alias |FEI'tigLIE_Check | -
Kxy = Txy min /Txy A Description | |v Loa 3 Load Group Only
Show Parameter Description Selection |'! Entities| | Lf”
Allowable Stress
Parameter = Kappa (Fappa Factor) s
All: if{Sweldlibs > 0, SweldMin / SweldMax, SweldMax / SweldMin
&
a) k<0 Parameter = Sf (Stress Fatigue)
- for tension : 0=5.04/(3-2.x) (1) B11l: Min(units.FromPaTcCurrent (Switch({MaterialType, Fe360, Sf Fe360(ElementGroup, WeldType), =
=
Febl0, Sf Febl0{ElementGroup, WeldIype))), Stati Sellow)
- for compression : 0c=2 . = K (2) )
| | |Farameter = Sallow fatigue (Allowable Stress Fatigue) 1
Ow is given in table above. B1Y: if (Eappa > 0; if(SweldAbs > 0, (5 /3% S}/ (X - (.- [5 /3% 8f) [ (0.75* tensile))] * %
Kappa), (2% SE) / (1 = [1-— (2 * S£) / (0.9 * tensile)) * Kappa)), if(Sweldhbs > O0; (3 * Sf)
b) K>0 (3 -2 * Kappa), {2 * 5E) / (1 - Kappa)))
- for tension o =0p/[1-x.(1-05 Eqv.: 0
- for compression 0.=1,2.0 [ Parameter = Uf (Utilization Factor)
' L1l: Rbs3 (5w Aha) F Min(Static Chec 2110w, Sallow Fatigue)
KY¥: Abs(Sweldlba) / (Min{Sta: : ¢ Sallow Fatigue / if(ReldType <= Weld K4, 3QRT(2),
SQRT(3))))
¥Z: Abs(3weldRba) / (Min{5tat hie 2llow, Sallow Fatigue / if(WeldType <= Weld K4, 3QRT{2),
s . . SQRT(3))))
Utlllzatlon Factor Comblned Z¥: Bbs(Sweldlba) / (Min(Scacic Che s1low, Sallow Fatigue / 1f({WeldType <= Weld K4, S5QRT(2),
SORT (31431
Egv.: pow{me.x, 2) + pow(me.y, 2) + pow{me.z, 2) + pow(me.xy, 2) + pow(me.yz, 2] + pow(me.zx, B)

2 2 —1|- Zign(Sweldibs.X} * me.x * sign(Sweldhbs.Y) * me.y - sign(Sweldhbs.¥Y) * me.y * sign({Sweldhbs.E)
(meaxlo)(a) + (C'ymax"Uva) = 4—/_ ¥ me.z — sign{Sweldabs.Z} * me.z * sign{Sweldhbs.X) * me.x -
Oiomax: s Uymax/(loxa | . | Oya | ) + Overall: Max(me.x, me.y, me.z, DE.XY, DE.Y¥Z, ME.ZX, Sgrtime.eqv / 1.1)) L

2 v |
('nymax/'cxya) <1 : - = = - : ;
B B %S Enf B B Cearresuts oK Cancel
where the siress values oxs, 0ys and T4y are those resulting from the application of formulae (1),
(2), (3) and (4) limited to 0,75 . or.
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Stress Fatigue

Stress Fatigue is used in Fatigue Allowable Stress calculations. Stress Fatigue depends on:
- Weld Type (W0-W2, KO-K4);
<0 - Element Group / Loading Group (B1-B6);
- for tension : o=5JoulJ3-2.x) (1) - Material Type ( St360/5t37, St510/5t52).
- for compression : gs=2 Jowll(1-x) (2)
Table T.A.3.6.1. . Corresponding values of Stress fatigue in SDC Verifier:
Values of ow depending on the component group and construction case (N/mm?)
Welded components 7 Extreme Table = o
Unwelded components Construction cases Gy ae
Com- Construction cases (Steels St 37 to St 52, Fe 360 to Fe 510)
ponent Wa | Wy | W E— R F i et e 2o Exreme X Y z Xy Yz 2 Eqv Overal
group |Fe 360 Fe 360 Fe 360 O LM e RSl ERe) |
St37 | St52 | St37 | St52 | St37 | St52 Ka K Kz Ks Ka ekt ™1 | Vaiue I'ss.sue.s 11380055 | 12750846 I | [147.80046 00086
St44 |[FeS510| St44 |Fe510| St44 | Fe 510 Options Bement D 1 326 326 |1 1
E1 | 2491 | 2980 | 2117 | 2533 | 174,4 | 2086 |(3619) |(d23,1)|(2714)| 1939 | 1163 1 e ]| | M '
s Faign | | | .
E2 | 2244 | 2617 | 1907 | 2224 | 157,1 | 1832 |(2938 Load Gr [1-Losd Goup 1 [ [ e L i IR e
. : 5 ; ; 2 |(2938)| 262,3 | 2203 | 157.4 | 944 w [ e & = = . .
Table Type Parameter over Directions S| [ 2pscase I T T T
E3 | 2022 | 2208 | 1718 | 1953 | 141,5 | 1608 | 2384 | 2120 | 1788 | 127.7 | 766 !
I Parameter Stress Fatigue v Value 9560e+6 113.80e+6 127.50e+6 | 14780e+6 | 0.00e+6
E4 | 1821 | 2018 | 1548 | 1715 | 127,5 | 1412 | 1935 | 172,8 | 1451 | 103,7 | 622 Selection Bement (D ! i i 1 3
AL (kS| |G |G R (R
E5 | 1641 | 1772 | 1395 | 1506 | 114.9 | 1240 | 1571 | 40,3 | 1178 | 842 | 505 i
E6 | 1478 | 1556 | 1257 | 1323 | 1035 | 1089 | 1275 | 1138 | 956 | 683 | 410 7 [%
E7 | 1332 | 1366 | 1132 | 1162 | 932 | 957 | 1035 | 924 | 776 | 554 | 333 2B
Blements 12400
E8 | 1200 | 1200 | 1020 | 1020 | 840 | B40 | 840 | 750 | 630 | 450 | 270 -
ax Cancel

5 www.sdcverifier.com



Weld Type

Weld Type — also called Notch Case, defines which elements belong
to what weld type (KO-K4 — joints affected by welding, WO-W2 —

Case K2 - Medium stress concentration

Reference | Description Figure Symbol
] H Parts of different thickness butt ]
elements and joints, not_affected by welding). Weld Type depends wikieed (0,61 at gkl angles 1o «[—_\'__,_ = >b
on shape, structural design, whole pattern or type and quality of 2,1 direction of the forces. Asymmetrical Zz
slope : 1 in 3 (or symmetrical slopes : “DE" ><
welds. 1in2)
Cruciform joint made with K-welds D
24 (S.Q.) perpendicular to the direction of yé ét(
Case W, the forces o
Reference | Description Figure Symbol
Parent metal, homogeneous surface. - ;
Wo Part without joints or breaks in continuity Butt wold with bagfijr?g ;?i;)?aﬁ;er:i Slrens Concerirabar
(s?hd bta:]rs)I at?d wnhc:;.n noltch] etﬁzcts P 3,11 backing run. Backing strip secured by ‘.»@ —_— <
Hloss e e colybe oot iaiad. intermittent tack welds
Case K - Slight stress concentration 4
Cruciform joint made with K-weld D
Reference |Description Figure Symbol 34 (0.Q.) at right angles to the direction E f
- of the forces >
0,1 Parts butt-welded (S.Q.) at right 'D I
angles to direction of forces P 100 Case K, - Very severe stress concentration
= 'D <}
A Reference | Description Figure Symbol
Case K1 - Moderate stress concentration Parts of different thickness butt I_b__ >b
4,1 welded (0.Q.) at right angles to the ] =&
Reference | Description Figure Symbol direction of the forces. Asymmetrical
P >b position without blend slope ><
Parts joined by butt welding (0.Q.) at P 100 . o . 4 D
1,1 right angles to the direction of the Cruciform joint made with fillet weld ZIN
forces - - or P10 44 (0.Q.) at right angles to the direction
>< of the forces Pos
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Element Group

Example of Load Cycles:

Load Cycles Number | Total
Moves per hour 30

Hours per day 10 300
Days per year 300 90000
Number of Years 20| 1800000
Total Million: 1.8

Class of Utilization B7 (1.8 million < 2 x 1076)

Table T.2.1.4.2. - Classes of utilization

Element Group also called Loading Group depends on: Class of Utilization, Load Spectrum.

Load Spectrum

Table T.2.1.4.3. - Spectrum classes

Symbol Spectrum factor ks,
P1 ke = 0,125
P2 0125 < kg = 0,250
P3 0,250 < kg < 0,500
P4 0,500 < kg = 1,000

L

+{0'ﬂf Gmax)c {nrl‘ n) = z [(Gilr Umax)c (ni /n)]

i=1

Total duration of use
Symbol (number n of stress cycles)
BO n < 16 000
B1 16 000 < n < 32 000
B2 32 000 < n < 63 000
B3 63 000 < n < 125000
B4 125 000 < n < 250 000
B5 250 000 < n < 500 000
B6 500000 < n < 1.000 000
| B7 1 000 000 < n < 2 000 000
Bo < Ubb 0ou < n 4 4 QU0 000
B9 4 000 000 < n < 8 000 000
B10 8 000 000 < n

ng+tnet.....+n.= n =
i=l
Element Group
Table T.2.1.4.4. - Component groups
Stress Class of utilization
Spectrum
class | Bo | B1 | B2 | B3 | B4 | B5 | B6 | B7 || B8 | B9 | B10
Ef E1 = E1 =) E3 B [ B | B E7 E8
E1 E1 E =2 E3 E4 5B [ B || &7 E8 =3)
P3 E1 E1 E2 E3 E4 E5 6 E7 E8 E8 E8
P4 E1 E2 B2 = =3 E6 E7 E8 E8 E8 E8
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Open the starter model

Launch SDC Verifier .

Open project F.E.M. 1.001

- O
File Settings Model Recognition Job  Tools  Standard  Post-Processing  Results  Report  Help
O o T e - T o9 B8 E S8 B | A 4L o= Pl GoToEmbed Mode
i
Open X
&« v > ThisPC » data2 (E) » Projects » InWork » Eurocode3 and FEM1001 Fatigue v B Search Eurocode3 and FEM10.. 2
Organize ¥ New falder
Name Date modified Type Size
# Quick access
2. I B F.E.M. 1.001 3/25/2016 71:19 AM  SDC Verifier Project 79 KB I
@ Nextcloud
E“; Dropbox fron
@ OneDrive
&3 This PC
¥ Network itior
Messages i
15:14:34 Floating Licens File name: | FEM. 1.001 v| | S0C Verifier Project ("sdevsd ~ |
o
Femap :
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Run Analysis

Press # to start Analysis in Femap

SDC Verifier 2020.0.2 - D:\Vitalik\Tutorial\for Femap\Eurocode3 and FEM1001 Fatigue\F.E.M. 1.001.sdcv = [u] X
File Settings View Model Recognition Job Tool Standard Post-Processing Automation Results Report Help
Damese® | dg+ BO 0BG FOmo & L8 s L Fl GoToEmbed Mode
l.
D [1 | Ttle  [Job1 |
Description [ | v |
Analysis Linear Static s
Analysis Options Define... Select Loads to be Analyzed (5/5)
Request Results

0 Dwteanet 0 30 b —
AT i g m—

[ Applied Force [ Force Balance

& Re Foce [J g:gm Equation Sold Stress/Strain: | Comer Resuts
] Blement Force Plate Stress/Strain: | Comer Results i
Aeely

14:51:55 Model D:\Vitalik\Tutorial\for Femap\Eurocode3 and FEM1001 Fatigue\F.E.M. 1.001.modfem is opened A
14:51:57 Updating Joint Finder..
14:51:57 Updating Beam Member Finder.
14:51:57 Updating Weld Finder..
14:51:57 Updating Beam Section Finder...
14:51:57 Updating Pane! Finder...
14:51:57 Updating standards..
14:51:57 Project D: \Vnaik\TmonaNor Femap\Eurocode3 and FEM1001 Fatigue\F.E.M. 1.001.sdcv was opened v
Nodes: 37803 ; Elements: 39707 | D:\Vitalik\Tutorial\for Femap\Eurocode3 and FEM1001 Fatigue\F.E.M. 1.001.modfem MKS (Meter/Kg/Second) | Femap .:
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Weld Finder

Execute Recognition =>Weld Finder =>
Edit...

Press Find.

Press Close.

Press E',-o’ to Export selected sections to

OOG

Bl Model
l’ﬂﬁReoog'l‘tion
A Joint Finder
¢ Beam Member Finder
-7 Beam Sections Finder

| E'J_
I & | Jobs (1) # Edit

Check weld design — g

Unable to recognize weld parameters automatically. Welds that match one of the following
criteria are displayed:

#  Type Description lssue
1 | Waming | All weld parts in a weld are welded | Continuous parts in real model will be treated as welded
2 Wanmg | Dfferent weld part lengths in a weld Different area of the weld that will lead to stress variation

3 Emor | Length of any weld part of a weld is zero | Possible mesh disconnectivity. Weld area is 0
D Title Nodes Blements  Length Crterion ~ Welded  Non-Welded
82 Weld 82 [-30.11; 12.75; 5.47] 25 72 1.010002 |1 3 0
190 |Weld 190 [28.77: 12.27: 5.47) s [24 |0.336667 |1 [3 [0
191 |Weld 191 [30.11: 12.27: 5.47] E] |24 |0338864 |1 [3 [0
192 | Weld 192[-30.44: 12.27; 5.47) 9 |24 10.336667 1 |3 |0

1= 8| ®

LIl

components
Veld
Add, Edit, Combine and Remove Welds.
Recognition ' Fiter
Fiter None v [E Apply Fiter FndWeldbyiD [ || Navigate
D Tie Tensde (Min) [Pa] Yield (Min) [Pa] IS’vm e lscuved  Nodes Bements  WeldPats I T
1 Weld 1[-29.94; 12.75: 5.95) 0 0 Yes No 29 84 3 &
2 Weld 2[-29.94; 12.75, 6.85] '[l 0 ‘Tes ‘Nﬂ 24 ,63 13 =1
3 |Weld3[-29.54;1275:7.54) ] 0 |Yes [No 15 42 I 'd parts by elements | | Set non-welded parts by elements 3.
4 |Weldd[2934:1275:8.19] 0 o [Yes Mo s & 3 X \
5 | Weld 5[29.94;1275; 8.84] [0 [0 [es [No [15 [#2 3
6 Weld 6[-29.94: 12.75: 9.48] 0 0 Yes | No 24 [3:] |3 @
7 |Weld 762994, 1275, 1026] 0 0 [Yes — INo 20 57 B B
8 Weld8[29941275:11.02] [0 0 [res o 19 E 2 <) .
3 IWaSN:1228 3% [o [o T N - There were found some Welds with
10| Weld 10}29.54: 12.14:689] o o [Yes [No EZ & I3
n 0 0 Yes No 15 42 3 . H H
0 : . : fogo1e 2 B all welded Parts; click to close this
13 | Weld 13(-29.94; 1196:8384] 0 0 Yes [No 15 a2 3
4 |Weld 141:29.54: 11.91: 543] [0 o | ves No [ 69 3 message
15 |Weld 1562096 11,84 1026] o o s 1o A
16 |Weld 16299 1176, 11.04] 0 0 Yes Mo ) 57 3
17 |Weld 17[-29.94; 1172, 1149 lo 0 Yes No |4 9 |E L.
ek 81296 126:52) o o LS L S R Move Welds. Order is important when one
19| Weld 191296 126:54] [0 o Yes No 5 12 3
20 |Weld20[-296:126:597 0 0 Yes No ® & 3
21 Wad21 (295 126,659 o To Yo M 2 R = / element belongs to 2 welds.
2 ‘deZZ[Q?E‘ 12.6; 7.54] 0 0 Yes No 15 42 _]
2 Weld 23 [-29.6, 12.6. 8.19] 0 0 Yes ‘ No 24 69 13 v
24 |Weld 2429, 4] 10 |0 i e 15 2 13 = .
25 |Wed 25[296:126:949) [0 0 Yes [N 2 E 3 ! Preview selected welds
26 |Weld 26 [-29.6; 12.6: 10.25] 0 |0 Yes | No 20 |57 3 4
27 |Weld 27 (296, 126, 11.04] lo 0 Yes No ] 57 3 .
2 |Wed28(296:126:1159 0 0 Yo Mo 5 5 2 2
2 |Weld29[296:12.38:5.28 0 0 Yes to 2 4 3 _ . .
S sy 0 ; e ——— » Plot of selected welds in colors and with
31 |Weld31[-296;1238:597] o o [Yes No [30 [87 13 de

labels of IDs

10

Set Parameters | | Check on Weld Design

OK

Cancel
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Weld Finder. Export

E
@ Click As One Component As One Component
Each Item as Component
@ Press OK. As One Group
Each Item as Group
Enter Component Title X

LS Selccted Welds] |
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Stress Transformation

Stresses for weld elements are automatically transformed =y
in the direction of the corresponding weld from Weld
Finder Tool using the wedge method. Stresses are
transformed only for plate type elements.

Oxx 1O Oxx—O
ann=( xxz yy) +( xxz yy)*c0529+ Txy * Sin 26

_ (O'xx_o'yy)

*8in 260 + Ty, * cos 26

_ (O_xx+0_yy) (Gxx_ayy)
2 2
Oxx» Oyy, Txy — Original x,y and shear stress in local element x, y and shear directions

Ott) Onn, Tne — transformed x,y and shear stress in weld x,y and shear directions
0 - angle between the element and weld x directions.

* COS 20 — Ty * sin 20
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Add FEM 1.001 standard

Execute Add => F.E.M. 1.001 in
Standards context menu.

®

T Py e

i ot and s

%53 Post |4+ Add »
; 8. Optimizations| |, pepame Multiple

“-[4] Reports (0)

Remove Multiple

+ 111

Renumber
Clear results

E Load from Library

F.E.M. 1.001 - performs static stress
check and fatigue check for steel
structures of crane and crane
equipment. Fatigue calculations are
performed according to Allowable Stress
Design method (ASD).

13

ABS

AlSC

API

ASME VIII (2010)
DIN 15018 (1984)
DNV

DVS 1608 and 1612
EN13001 (2018)

Eurocode3

F.E.M. 1.001 (3rd, 1998)

DY DN UODDNDNDDRHRE®R

FKM (5th, 2003)
I1SO 19902 (1st, 2007)
Norsok NOO4 (rev.3, 2013)

Comparison Standard

Custom

www.sdcverifier.com



F.E.M. 1.001 Standard

OIONNOIO

14

Selection: All Entities

Press “* to edit material properties.

Amount of materials with not defined
Tensile or Yield are displayed in the field

Tensile Strength: 360e6
Yield Stress: 240e6 and Press Set.

Press OK.

Unit System. Stress Fatigue values are
constant for specified material and are
measured in Pa. Changing unit system
enables to convert Pa into Mpa, for
example.

: FEM 1.001 (3rd, 1998) - 0O X
ID [1 ] Tte [FEM1.001 (3cd. 1998) |
Weld Type (A-36.1) | || A sl B R R K9
Blement Group (Chapter 2.1.4.4) | || | T |~ (4

I.
Material Type (A-3.6.1) [ | | M, . RS
Materials with Yield and Tensile = 0 d 2L
Safety Factors for Static Stress Check ¥
Bemerts
| | o8] oK Cancel
1
Material Fatigue Parameters - a X
Materials Tensile Strength [Pa] Yield Stress [Pa] rT:_'ﬂ;S h [Pa)
1..5355 360000000 240000000 60e6
Yield Stress [Pa]
3. [ ]

]
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Definition of weld categories

» Weld/notch category determines fatigue resistance
» Division in welds / non welds for FEM 1.001:

W category is for non welded parts

K category is for welded parts

» Fatigue resistance is further specified by adding classes
WO0-W?2 for non-welded parts
K0-K4 for welded parts

» Better fatigue resistance results in lower class number

15 www.sdcverifier.com



Weld Classes depends on Weld Type

Non-weld group WO
nr. descrighlon of the naln ypas synbol
Wi Part vithout hole and without joint, i -
with & nornal state of the surface, (\
without notch behavicur. R
Slight notch behavior group KO
nr. description of the mafe types sysoal

_

-~
Q‘ 011 Parts, jointed by a butk veld of zpecial

-1 quality, perpendicular to the direction
of fores,

{D#)P'Iﬁﬂ

ad><p p 100

Great notch behavior group K3

311 | Parts jointed by a butt weld with a backing
strap, without sealing run znd perpend-
jeular to the direction of force.

Racking strap fixed by tack weldinp.

S

and a different connection type 351

<

nr. deseription of the main tvpes

eynbal

L Double bevel weld af ardinary 1JB|I’{'}'.
pnrrlt-.rli'lcu] ar to the directiee of foree,

=

\/D

| -~ betwsen erossing parts.
Moderate notch behavior group K1
1
far. duscription of tha maln types symhal vew great notch behavior qroup K4
111 Parts, Jointed by a butt weld of crdinary — 1
o e L desaription of the mafn types symd
quality, porpendicular to the dinaction Por " e o e "
ot ok \\% 100 12 | Parts of difierent thicknees, jointed by
Poar b . {1 s s Al q =
= a butt weld of wrdinary quality, W
- P 100 perperdicul af 40 the direction of Force, u :>+> P
dgyanetrical Jolnt Without elope, - 1: — > B
Medium notch behavior group K2 _ i
and a different connection type 451
nr. deseription of the main types synbal

n Prafiles, jointed by butt welds of spocial
quality, parpondicular to the direction of
farce,

Ct)FpPIUD
o< P10

16

451 | Fillet walds of noreal guality or single
beval weld [included F111el wald) ulth

batking, percendicular fo the di
of force, between crossing parts. ‘

AND
N\D




Welt Type — stress direction

_ Perpendicular to weld | Parallel with weld _

Weld K1 K2 KO

No weld tp(-1) = op(-1) / sqrt(3)

_ op(-1) for k=-1 element group 5 St 52-3

Notch group w1 W2 KO K1 K2 K3 K4

Stress

. 163.8 130.3 104.2 118.8 106.1 89.1 63.6 38.2
amplitude
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For beams SCF of connections can be included in the

(not included in this tutorial)

18

Depends on Stress concentrations:

Slight notch behavior group KO

M3

Gusset, jointed by cutt welds of special

ouality, perpendicular to the direction

of force.

}

>4 e

<o p 100

classification

Moderate notch behavior group K1

13

Gugset, jointed by butt walds of ordinary
quall by, nerpendicular o the direction

of force,

.

For
P 100

P ar
~ P00

Medium notch behavior group K2

13

Butt weld of soeelal quality end contirwous
part, both perpendicelar to the diraction
of force, at a erossing of flanges uith
Tnevelded corner plates, The ands of the
wolde gre ground to prevent them from
rotch behavlour,

>4 b 100
of><p P 100

Great notch behavior group K3

3

Very great notch behavior group K4

413

Butt weld of ordinary quality asd continuous
part both perpendisular to tha direction of
Farce, at a crossing of flanges with weldod
zarner plates, The ends of the welds have
bean ground to prevent them frem noteh

behavioer,

Butt weld of ardinzry quelity, perpandicelar)
to the direct f farce, at a crossing of
flanges without corner plates,

P ar
P 100

P oar
=~ P 100

>hoe

=P




Weld Type Classification

Press Ok-->Yes (Define for the Weld
Type).

Press [E to Add Condition.

Press Add all Welds

Select Multiple Conditions options

Press X/Y/XY

X: K1 Y: K2 XY: KO

Press OK

Jolololo0lole

ID [1 | Ttle [FEM 1.001 (3rd. 1958)

[Standard1

Description |

Settings
Weld Type (A-3.6.1)

SDC Verifier

Bement Group (Chapter 2.1.4.4) o Weld Type (A-3.6.1) is not set. Define?

Material Type (A-3.6.1)

Materials with Yield and Tensile = 0 l No

o}

Safety Factors for Static Stress Checkr

L| | 1.

19

|

7@

|

&
X

oL

Cancel

3.

Edit Classification - *
ID [1 | Tile |Weld Type |
Alias |WeldType |
Description | |i W |
Element(s) Classfication
Weld Type Enum |KD v| | Apply |
Direction X V | Apply |
Mo. Selection Classffication Ez_
&
0
x
Classification Condition — O X
Selec_ti_on__ — Weld Type Enum
'm.l.l :k‘- | () One Condition |@ Muttiple Conditions I 4.
+ Al welds B3 6 [ A | Nene |[ vy | ||S.
v X Ex | [k ~ il
B p [Ar| ke = ~
1z | k8
Elements 8032 : o "
poiz | w| @ =
| [ Addallwelds | I Add all welds interssctions | R
| IOy [k ==
Czx |Ko
[]Egv. Ko
7.] ok ||| cancel

www.sdcverifier.com



Weld Type classification intersecting welds

20

@ Press = to Add Condition. Edit Classification - %
@ Click All welds intersections D 1 | Ttle |Weld Type |
Alias |We|dType |
@ Value: K2 Descipin | &4
Elementis) Classification _
o Weld Type Enu KD v| | Apply
@ Directions: X s H Ee
Direction X v| | Poply
Press OK Mo Seledioﬂ Classification | E I.
1 | Full Model 'wo 7]
2| Alwelds K109
E 1
Classification Condition O x s K2 (Y)
X
Selection Weld Type Enum =
aul s (@) 3] (3] (&) [ @ OneCondtion O Mutiple Condions el
+ All welds intersections Al g Vake 3. D v
BB | orecions TR = At intersecting welds all stresses are
ol +. [C perpendicular to the weld direction.
gz The last condition overwrites the
Element il . . .
’ %g previous ones and settings in
Addalwelds || Add ol welds intersections | 2. Ea{ o condition 2 => K1 (X) are replaced "1
UIV
with K2(X) for intersections -
|“|
v
5 OK Cancel
. Irnp_nrt Welds CIK | | Cancél
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Check classification

Edit Classification
ID [1 | Tte |Weld Type ]
Alias |WeldType j
bon >
Descrption | ] .
Blement(s) Classffication A
Weld Type Enum Ko Aoply X st Z
Direction X Apply i1
S1:1
No. Selection Classffication o
1 | Full Model wo :
1 : &
2 | Alwelds K1 ()
3| Alwelds K2 (V)
4 | Alwelds KO (X) x
2 <
L
Y
«f“\
X st 7
O:1
C11
El X 1.
s Y 2.
= F 4
import Welds oK Cancel XY
YZ
ZX
Equivalent
21

E
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Element Group classification

@ Press M= for the Element Group. Add Element Characteristic - B X
ID 1 | Tile [Blement Group |
@ Select Element Group: E6. Press To All. Aias [BementGroup |
Descripton | | v!
@ Press OK. Hemental Selections
Element Group Enum 2. |E6 v| | Apply To Selected To Al
ID Selection Value o
3
(18
X
2
W
£ L
L
3 oK Cancel
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Material Type classification

Press . for the Material Type.

Select Material Type: Fe360 (Fe 37).
Press To All.

Press OK.

Press OK to create Standard.

OlOIOIO

Material Type defines which steel is used: St37
or St52. Stress Fatigue values are different for

different materials.

23

Materials Characteristics = a X
D 2 | Title [Material Type |
Alias IMateﬁalType I
Description IFe3600r Fe510 | v
Materials
Material Type Enum .| Fe360(Fe 37 v | | Apply To Selected |

Material Value o
1.5355 Fe 360 (Fe 37)
3 OK Cancel
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Create extreme table

=] Standards (1)
- =8 1..FEM 1.001 (3rd, 1398)
Execute BA Table (expand/extreme) in - Input
. E)-[¥] Checks (3)
Fatigue Check context menu. gl
. (& 3.Fatigue S| + Add b
. 43 Post-Processing o .
(3] & Edit
Load: 1..Load Group1. "5 oo @ | ¢
i [@ Reports (0) )] ename
B Copy
Fatigue check supports only Load X Remove
Groups. If only one load group exist in Copy To Standard...
the project it will be selected Clear Resuits
automatically. |-|ﬂﬁ Teble (expand/extreme)
@ Components Extreme Table (over selections)
% Flow Table (over loads) =
16:17: 1 !
Table  Type: Parameter  over S S Bec | caama
Directions. e e e ] ConbourPict
Cunum(heckTahle B A - ) —
@ Parameter: Utilization Factor. G e
D !1 ‘ Tile | Extreme X ¥ Z | XY YZ : X
Do | | [ Fvae | 000 0% l 000 |
1 . H 1 Options B [} 37146 83465 21985
Selection: All Entities. i T Siawt | |
2. fosdGow  [1loadGroup 1 (] | [veke | 20 12 : 101
l - | Bemert ID 1139 37547 | 37547
Table Type Extreme (worst resuit on selection) v — | i |
Press Fill Table. 3. e S Poranderover Decins i i 1 200 1% " 1w
4.I’lamde( Uiization Factor v | |Bement ID 1133 | 37547 37547
Exreme Options
@ Detailed (extreme locations - element and load for Load Groups})
O Shott {only extremes)
@ Press OK. —
Al ksl (B0 [G (&)
+ All Entities AL
5. v [x
88
Blements: 39707 <
Set Defaul Tie | 6. FiTabe T.| ok | concel

www.sdcverifier.com



Create criteria plot

Execute B2 Criteria Plot in Fatigue Check
context menu

Parameter: Utilization Factor

Direction: Overall

Point of interest: Total Type: AbsMax

Press GI Preview

Press OK

ODOOOOO

]

andards (1)

~
= 1.FEM 1.001 (3rd, 1998)
&

@@
{

1..Static Stress Check

®
+-F8 Table{ # Add »

-[E] 3.Faligue| § gt

(3]
(3]

@ Optimizations (0) |~/ fename
[d] Reports (0) [E] Copy
¥  Remove
Copy To Standard...
Clear Results

B Table (expand/extreme)
@ Components Extreme Table (over selections)
)

Criteria Plot - X
ID 1] Tee |
Description | | v
Check [2. Fatigue Check | A és) )R] | A
Load Group [1..Load Group 1 | A S
Parameter 2.  kilization Factor bt v ,x‘
Direction 3. | Overal v 9 4@
L Absolute
Point Of Interest 4. | Total v| Type |AbsMax v
View 1. Default View v|[#] [#]  Bemens
Labels None | #]  ums . [Nene | |

Set Default Title 5.| GI OK Cancel

I. [ Criteria Plot

m COI‘I!UUT p 5‘

Point of interest = AbsMax Total is absolute
maximum utilization factors among all point of
interest.
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Report. Tables and plots

Results => Check Tables

==

Expand/ Components
Extreme  Extreme

Press => Check ‘2..Fatigue Check’

=>E

Bl First Page

I+ Table of Content
Pl preface

Table Type: Extreme.

= [V Results
& ] 1.Static Structural
@ Y2V Individual Loads

] Load Sets

@ HHJ] Load Groups

Load Group: 1..Load Group

@ B summary
# CIV] Appendix

Selection: All Entities.

Parameter: Utilization Factor.

DOOOGOOO

Press OK.

Add

— Remove Multiple

Renumber

¥, Generate Multiple

L[

Wizard - Empty
Wizard - Model Setup
Wizard - Results
Wizard - Full

Designer - Empty
Designer - Model Setup

Designer - Results

2 slPpp PEOD

Designer - Full

Presentation

Post Processing

Flow Summarized Forces
Table  (over Selections) Forces (over Loads)

Import

2|
Il

Summarized

EQ L a

Criteria Contour Histogram Expand Beam Member
Graph Diagram

B

Tables

Extreme Settings
(O) Detailed (extreme locations - element and load for Load Groups])
(®) Short fonly extremes)

Parameters

Kappa Factor
Stress Fatigue

Allowable Stress Fatiiue

6.

4

Add Check Tables
] & Standard '1.FEM 1.001 (3rd, 1998)
2.
ecl ..rabigue summation

Custom Check Table I} — =

4. 5

Loads | | - Selections (1) (Elements)

Count LG1..Load Group 1 I5:ii I
o EE T
_LI Table Type |Eme111e {warst result on selection) w ;
Table Structure | Parameter over Directions v |l_ ::

x

2
2

!QD
o= [&]{a) >
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Report. Tables and plots

Results => Check Plots

Press => Check 2..Fatigue
Check’ =>

Direction: Overall

Point of Interest: Total.

Selection: All Entities.

DOOO OO

Press OK.

27

f

Home Insert

PostProcessing  Import

m R & %

Expand / €

Flow

P ized Forces g
Extreme  Extreme Table  (over Selections) Forces (over Loads)

EHE W m

Criteria Contour Histogram EGupand Beam Member = Chec] Check

raph Diagram Table
Show Parents Add Check Plots - o %
£l First Page = Standard “1.FEM 1.001 (3rd, 1998y 2.
EIR Teble of Content Check '1.Static Stress Check'
Preface 2.1 Check ‘2.Fatigue Check
= bl [V] Results Z
2k 1..Static Structural
® 42V Individual Loads
® ##[7] Load Sets
= Y4 Load Groups
@ ¥4J] Load Group ‘1.Load Group 1'
BBV Displacement (LG1, All Entities
HB[V] Abs Usum (LG, Al Entities, v
B Abs
o H 1.v1| A CheckPlots %
B 1
Loads Selections (1) {(Eements)
iy Court LG1. Load Gi 1
L .Load Group & -
= o[ @ |
B = - _ S
@ 7] Load Gr Pamelas LigEE All Erttities | g |
Kappa Factor &
# 2] Load Gn Stress Fatigue

® [V Summary
@ [J[V] Appendix

Absolute

Views

[ 1. Defaut View

Points of Interest

[End 1/ Top

Total calculation type ' AbsMax

Limits None

~

2

:’:

b
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Report. Fatigue Check

Insert => Appendix => Standards
Description

Choose 1..FEM 1.001

Press OK.

Expand stapdard 1..FEM 1.001 =>
Generate . 4

OO OO

= ¥ Load Groups
= ¥¥V] Load Group ‘1..Load Group 1'
BV Displacement (LG1, All Entities)
EB¥] Abs Usum (LG1, All Entities, v1)
EB[¥] Abs Seqv (LG1, All Entities, v1, Total) 4.

Home Insert Results Post Processing Import
E E . £ User Chapter [ Model Plot
M i TText :rg: Group Plot
Table of Preface Model Model Recognition —I
Content Information Setup Tools + £_Image ~  Appendix ~
troduction Model Description Additiona Full Chapter
Select Items - O X :
N Standards Description
i Search
B Firstpal Characteristic Plots
El¥ Table o . Classification Plots
FI™ prefacd  Filter ‘ ‘Il
]

[ 1.FEM 1.001 (3rd, 1998)

= B
m ) |l§] Generate
@ ¥V Load Group ‘2.L1-L4

#® ¥V Load Group '3.12-14'
® ¥V Load Group '4.L3-L4' Copy
& Summary y Cut
® V] Appadix : i:r:ove
Select ltems
Apply to Selected

re
Ctrl + C
Ctd + X
Del

28

Cancel

57
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Report. Results

2..Fatigue Check

Property Value

Category Elemental Custom Check
Selection All Entities

P 4

1..Utilization Factor (LG1, All Entities)

Standard 1.FEM 1.001 (3rd. 1908) Check [S1] 2. Fatigue Check
Load Group LG1..Load Group 1 Parameter Utilization Factor
Selection All Entities.
eme X L r4 XY YZ ZX Eqv Overall
Minimum
Value 0.00 0.00 0.00 0.00 0.00
Element ID 37148 83455 21085 23624 22151
Maximum
Value 200 190 1.01 4.04 20
Element ID 1139 37547 37547 37547 37547
Absolute
Value 2,00 1.90 1.01 4.04 201
Element ID 1139 37547 37547 37547 37547
2..Utilization Factor (LG1, 9 Selections)
Check [S1] 2..Fatigue Check Load Group LG1..Load Group 1
Parameter Utilization Factor Selections 2
omponents X Y & XY YZ X Eqv Overall

Plate '4_sti pit 10 mm 0.73 11 0.24 1.00 in
thks’
Plate '5..stl pit 8 mm 037 058 0.18 033 058
thks"
Plate '6..stl pit 15 mm 2.00 162 0.0 372 2,00
thks’
‘::‘atg *10.stl pit 4 mm 0.40 0.40 0.04 023 0.49

s
Plate "11._stl pit 12 139 100 1.01 4.04 201
mm thks’
Plate "12_stl pit 24
mm thks'
Beam '13_stl L-bar 008 003 008
100x65x8 mm"
Beam "14..st L-bar 0.67 045 067
100x65x8 mm (top)’
Beam "15..sti L-bar 0.94 080 084

100x65x8 mm (side)'

Utilization Factor (LG1, All Entities)

Standard 1..FEM 1.001 (3rd. 1908)
Load Group LG1..Load Group 1
Selection All Entities

treme X L
Minimum 0.00
Maximum 2.00
Absolute 2.00

Check
Parameter

XY
0.00
1.01
1.01

[S1] 2..Fatigue Check
Utilization Factor

ZX Eqv Overall

0.00
4.04
4.04

Overall Utilization Factor (LG1, All Entities, v1, Total)

Check [S1] 2..Fatigue Check Point Total

Load Group LG1..Load Group 1 Parameter Overall Utilization Factor

Selection All Entities View 1..Default View
www.sdcverifier.com



Eurocode3d Stress history

» A better fatigue damage can be made if load cycles are specified more
accurately.

» Instead of 2 million load cycles from start to end:

L4-L1 0,5 eb LS4, LS3, LS2, LS1], IL1
L4-L2 1,0 e6 LS4, LS3, LS2, IL1
L4-1L3 0,5 eb LS4, LS3, IL1

NB gravity load is also included because the stress variation determines the fatigue damage

30 www.sdcverifier.com



Add Fatigue Group (stress history)

DOOOOOO

Select Fatigue in

Navigation tree

Groups

b SDC Verifier 2020.0.2 - D:\Vitalik\Tutorial\for Ansys\Eurocede3 and FEM1.001 Fatigue\Input data\ANSYS 19.2\Fatigue_files\dpO\SDCVVACT\Fatigue.ansv = [m}
5ys 9 P 9 9

File Settings View Model

Recognition

@E csoe® H+wp- B B0 & F=LF

Job  Tool Standard Post-Processing  Automation

Results

Report  Help

Title: Detailed load cycles pattern

Select all groups and press =~ 2

Select 1..L1-L4 and 3..L2-L4

Fatigue Item Cycles: 0.5e+6 and
Set.

Set 1e+6 cycles for 2..L3-L4

Press Create

@ Views (1)

- Model

B8 Recognition

-k Jobs (1)

B 1. Static Structural
48 Individual Loads (5)

4§+ Load Sets (4)

i X

&

. Optimizations (0)
-] Reports (1)

Add Fatigue Group

D [T ] e

[Detaied load cycles pattem | 2. ]

K%

ALL
1..Load Group 1

Fatigue tem Cycles

2.L1-14

4134

5

I 0.5¢6 I SdtoSelﬁ:lch 6.
—

I}

000 000
| 500000

Total number of load | ~
cycles is calculated
automatically v

Total amount of cycles

2000000 || creae |7.

Direct stress range Aay [N/mm?]

10

' '
1,08 408 = s 1,0E+407

Endurance, number of cycles N

'
1,0E405

105404

1,0E+08

|
1,0E+03

1 Detail caregory Ao

2 Constant amplitude
Jatigue limit Aoy,

3 Cut-off limit Ay
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Fatigue calculation with Eurocode 3

Execute Add => Eurocode 3 Fatigue
(EN 1993-1-9) in Standards context
menu.

Consequence of Failure: Low

Assessment Method: Damage
tolerant

Damage 10

tolerant

Safe life 1.15
32

@ N Tools “
- e
; EJ1,.FEM1B‘ Add » |8 ass >
i O o7 Rename Multiple B aisc »
Remove Multiple B an >
Renumber B ASME VI (2010)
- Clear results H DIN15018(1984)
- I, Load from Library B onv N
i “-[E] 3.Fatigue Summation H D0vs1608and 1612
@ ¢d Post-Processing
"2, Optiwizations © B EN13001 2019)
%[ Reports (1) [H Eurocode3 » | B Eurocode3 Members (EN 1993-1-1, 2005)
F.EM. 1.001 (3rd, 1998) B Eurocode3 Welds (EN 1993-1-8,2005) I
FKM (5th, 2003) E Eurocode3 Fatigue (EN 1993-1-0, 2005)
H 150 19902 (1st, 2007) Eurocode3 Bolts (EN 1993-1-8, 2005)
H Norsok N0O4 (rev.3, 2013)
H Comparison Standard
H Custom
Eurocode 3 Fatigue - X
ID B | Tte |Eurocode 3 |
Description | |. v |
i s
FAT Class | || _Defice | [gu| k2] |
e ook _d 1
Reduced Range |2..Heduced Range | | Define | + Al Entities
Consequence of Failure | Low w |
Assessment Method | Damage tolerart -
118 — s
Materials with Yield = 0 o ||#| UntSystem [MKS (Meter/Kg/Second) | [
1.35 'y | ok || canca |
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FAT classes Eurocode3

_ Perpendicular to weld | Parallel with weld _

Weld 80 e n 100

< 100

Table 8.1: Plain members and mechanically fastened joints

No weld 160

Dictail
category

Constructional detail Descnption Requirements

NOTE The fatigue strength curve associated with category 160 | Rolled and exinaded products:
is the highest, Mo detail can reach a better fatigue strength at any
mumber of cycles.

Dictails T 33

1) Plates and flats;
2) Rolled sections;

1ol M 318 less haollow i
—_— ‘-..t _;| Seamless hal S{Ftlmﬁ.
w e cither mctangular or cincular.,
@ 3

Sharp edpges, surface and rolling
flaws to be mproved by grinding
il remvoyad and smooth
transition achicved,

- *-::-"'"‘--_\_

33

100

7) Repaired automatic or manual
fillet or butt welds for categories
L) to6).

7) Improvement by grinding
performed by specialist to remaove
all visible signs and adequate

verification can restore the
original category.

For determination of FAT classes check standard!
In this tutorial only examples are given
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Eurocode3 Fat Class

OOOEOG

Press Define for the FAT Class. s - X
ID 1 Title |FATC
Full Model: 160 | | o= JFATC |
Alias FAT |
All Entities: 100 (No weld) I i
Element(s) Classification -
FAT Stress 160 v | Apply
For welds: X: 100; Y/XY: 80 ; S
Direction X v| | Aoply
For welds intersections: X: 80 No. | Selecion Classiication *
1 | Full Model 2.|160| 7
4 | Al Enttties 3.1100 (XY, YZ, ZX%) B
2 All welds . 100 (X) ‘
3| Alwelds “lsogr. xn x|

5 | Al welds intersections 80 (%) p 8

| import Welds | [ox 1 cancsl |
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FAT classes plot

Edit Classification - X
ID [ | Trle [FAT Class |
Alias [FAT |
Description | | v
Element(s) Classffication Y
FAT Stress 160 v| | Apply Kol 7
Direction X N Apply o1
No. Selection Classffication L SR 160
1 |Full Model 160 y:
4 | A Enties 100 (XY, YZ. 2%) :
2 |Alwelds 100 ()
3 All welds 80 (Y, XY) x
2

®
_<

Import Welds

Y
2
N g o3 N[=<|>

Equivalent
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Fatigue Damage Plot

Execute Criteria Plot in Fatigue Check
context menu

Parameter: Summed Damage

Direction: Overall

Point of interest: Total Type: AbsMax

Press @ Preview

Press OK

DOOOOO

Check Plat - m| ®
L
Ip [ ] T |
Descrpton | [E3
Options Selection
- [ | N ) )
Fatique Group  |1.Detaled load cyclespattem | |1k | + Al Enttes »| [P
Show Resuitfor | FG1.Detaledload cycles pattem | v X
Parameter 2, Summed Damage Vi |@| U’il
Disction 3. |Overal '
Point OF Interest4_ W
View 1. Defaut View 1 [#] [#] | Bements
Labels [None | l#] Limts [None | [#]
Eal o .
| SetDefan Tre | [E ox ]l comee |
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Comparison

FEM 1.001 utilization factor
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